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Firmware Flashing for INVENT3D Printers 
Revision r1 

 

This document describes how to flash firmware on INVENT3D printers.  These directions only apply to 

Windows operating systems and refers to Windows 7 and Windows 10 directly.  Other operating 

systems may require deviations from the listed instructions. 

 

Here is what you need: 

 USB printer cable (USB A-B type, refer to photo on 

right) 

 Windows Vista or newer Windows OS 

 Administrative rights (you will add a device to 

Windows, you will run a downloaded program) 

 INVENT3D printer connected to AC power 

 Firmware file downloaded from our website (will 

cover what to download in Section 1 and 2) 

If you require assistance with these directions, please 

contact us by using http://support.inventorcloud.net/  

 

Image from https://commons.wikimedia.org/wiki/File:Cable_USB.jpg 

 

Section 1 – Determine what printer you have 
 

You must determine what printer you have before you download the firmware in order to ensure that 

you download the correct firmware.  Downloading the wrong firmware will lead to your printer 

behaving erratically. 

You can figure out your Firmware version by reading the LCD screen immediately after connecting your 

printer to AC power.  The firmware version is listed at the bottom of the display; refer to the graphic 

below. 
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The line always starts with the word INVENT3D followed by numbers.  You need to refer to the number 

and letter (if present) after the – mark.  This number will be any number in the list below.  If you have a 

single number as your type (or a single number and an H) then your printer type is 11 (or 11H if the H is 

present) and you should use 11 (or 11H) when appropriate. 

Printer Types 

1 11 12 21 22 31 32 

1H 11H 12H 21H 22H 31H 32H 

 

Be sure to write down what your printer type is.  You must flash identical type firmware to your printer 

unless otherwise instructed.  If you don’t know what type of firmware to flash, contact support! 

If you need assistance determine what type of printer you have (if the above mechanism does not 

work), refer to Appendix A. 

 

Section 2 – Download firmware 
 

Download firmware from our website that matches the type of printer that you have (the type number 

must match).  Flashing directions are identical for all printers, the only difference is the firmware that 

you download. 

If you download and flash the wrong firmware then you will need to identify your printer manually via 

Appendix A to correct that problem. 
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Windows 7 users must also download the Rambo driver listed on our website, it will be used in Section 4 

– Installing Driver Files. 

 

Section 3 – Connecting the USB cable 
 

You need to remove various parts of your printer to access the USB port on it.  Have your USB printer 

cable ready.  Follow the disassembly directions below to access the USB port. 

Be careful!  The parts you are handling are fragile and can break if dropped to the floor. 

 

 

Step 1 – As shown above, you need to remove the top plate.  With the print board positioned near the 

top of the printer, lift the right side of the top plate up and then swing the right side of the top plate 
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towards you in order to clear the right side of the printer.  Now you can remove the top plate by lifting it 

up and to the right.  Set the top plate aside in a safe location. 

 

Step 2 – Grab the LCD display and lift it up and out of the front plate.  After doing so, set the LCD face 

down on the table. 
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Step 3 – Grab the front plate and lift it up out of the printer.  Set the front plate aside in a safe location. 
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Step 4 – You can place the LCD in a normal orientation on the table (refer to photo above).  You can now 

access the USB port on the main circuit board.  Connect your USB printer cable to this circuit board and 

to your PC. 

 

Section 4 – Installing Driver Files 
 

Windows 8.1 and earlier cannot connect to your printer without having a driver.  You have to install this 

driver manually.  This requires administrative privileges and is an operation that IT staff typically carries 

out. 

The following steps should guide you in installing the necessary drivers on Windows 7.  Windows 8.1 

uses similar but not identical directions; seek assistance if necessary for adapting these directions.  If you 

run into difficulties, you can seek assistance from your IT staff or contact our company for further 

assistance. 

Step 1 – If you have not connected your 3d printer to your computer using a USB printer cable then 

power on your 3d printer (by plugging it into AC power) and then connect the printer to your computer 

(refer to Section 3 if necessary). 
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Step 2 – In Windows 7, you will receive an error saying that the device drivers could not be installed 

(examples shown above).  Dismiss any error messages. 

 

Step 3 – If you have not done so already, download the RAMBo_USBdriver.zip file from our website (we 

recommend you save all files to your Desktop).  Unzip that file by opening it (for instance by double 

clicking on the file icon) and then clicking on Extract all files in the command bar. 
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Step 4 – In the dialog box that appears, click on Browse… (Step A) and then select where you want the 

files to be placed (we recommend the Desktop) and then click OK (Step B).  Next, click Extract (Step C).  

Close any windows that now appear.  Your drivers will appear in the location you selected and will be in 

the RAMBo_USBdriver folder. 

 

Step 5 – Go to the Windows Control Panel using the 

Start menu. 
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Step 6 – Type “Device Manager” in the search field at the top right (Step A) then click on the Device 

Manager link that appears (Step B). 

 

Step 7 – Find the RAMBo device in Other Devices and right click on it (Step A).  In the menu, left click on 

Update Driver Software… (Step B). 
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Step 8 – In the new window, click on the “Browse my computer for driver software” option. 

 

Step 9 – Click Browse… next to the location field (Step A).  Now locate the driver folder that you 

extracted in Step 4 and 5, select it, and click OK (Step B).  After doing that, click Next in the dialog box 

(Step C). 
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Step 10 – In the dialog box that appears, click on Install. 

 

Step 11 – Wait for the driver to install. 

 

Step 12 – When finished, you will be notified of the driver’s successful installation.  Click Close to close 

this dialog box. 
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Step 13 – You will notice that the RAMBo option has changed to say 3D Printer powered by RAMBo.  

This indicates that the printer’s driver has successfully installed and you are ready to flash. 

 

Section 5 – Flashing firmware 
 

If all prior sections were appropriately carried out, you shouldn’t run into any problems in this section.  If 

you do run into difficulties, seek technical assistance. 

 

Step 1 – Download the appropriate firmware for your printer from our website.  After the download has 

finished, run the file.  
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Step 2 – If a dialog box appears saying an unrecognized app was prevented from running, answer the 

dialog box choosing to run the program anyway (refer to top 2 photos for a Windows 10 version of that 

dialog box). 

 

Step 3 – Click on the … button to the right of the Extract to: location (Step A), select a location to extract 

the files to (we recommend the Desktop) and then click OK (Step B), then click Extract to extract the files 

to that location (Step C). 
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Step 4 – A dialog box will appear showing the extraction progress.  When the progress finishes, the 

dialog box will disappear.  A folder will appear in that location that uses numbers and letters (similar to 

2.1-22). 

Step 5 – Find the folder extracted in Step 3 and open it.  Inside that folder, open the Arduino folder 

(similar to arduino-1.6.7) and then run the Arduino program in that folder. 

 

Step 6 – You may receive a dialog box similar to the one above.  If you do not then proceed to the next 

step.  If you do, first check both check boxes then click on Allow access. 
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Step 7 – Click on the File menu then the Open command. 

 



Firmware Flashing for INVENT3D Printers – r1  Page 16 

 

Step 8 – Navigate into the folder that was previously extracted (similar to 2.1-22) then the Marlin folder 

then the Marlin folder again (shown in top photo).  Open the Marlin.ino file (shown in bottom photo) by 

left clicking on it once then clicking on Open. 
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Step 9 – Another Arduino window appears in front of the prior one.  You can close the prior one by 

clicking on its’ program close X icon.  

Step 10 – Go to the Tools menu and 

then click on the Board option 

(highlighted in blue).  In the menu that 

appears, there is a large listing of 

possible board types.  Move your 

mouse cursor over the black down 

arrow to scroll the list down.  In the 

list, find the RAMBo option and then 

left click on that. 
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Step 11 – Go to the Tools menu and then left click on the Port option (highlighted in blue).  A list of COM 

ports are shown on the screen, in most cases there is only one choice you can make.  If you have 

multiple choices, the bottom choice is usually the correct choice (if things don’t work later on then 

repeat this step and select a different choice).  Select the COM port for your printer by left clicking on it. 

 

Step 10 – Verify that the correct board (RAMBo) and correct COM port is selected in the main interface, 

these options should match what you selected in the prior 2 steps. 
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Step 11 – Click on the Upload icon which is the icon with a right arrow (refer to above photo). 

 

Step 12 – A progress bar will appear and informational messages will appear in the interface.  Wait for 

the operations to complete. 
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Step 13 – When finished, the interface will state “Done Uploading.”  If there were any problems with the 

uploading procedure, a message will appear in the black area informing you of what is wrong.  If any 

problems were encountered, you can try uploading again after selecting a different COM port in Step 11 

or you can contact support. 

Step 14 – You may unplug the USB cable from the computer and remove the USB cable from the 3d 

printer. 

Step 15 – Using the LCD display, enter the menu and click Control then click Restore failsafe, it will 

appear like nothing happened on the printer.  Next, click on Store memory, it will appear like nothing 

happened on the printer. 

Step 16 – You may now disconnect AC power from the printer.  Reassemble the printer doing the 

opposite of what you did in Section 2. 

 

Appendix A – Printer Identification 
 

As mentioned in Section 1, downloading the wrong firmware will lead to your printer behaving 

erratically.  The firmware initially flashed on your printer is correct for your hardware configuration but 

you may have to visually identify your hardware features if firmware was flashed incorrectly (therefore 

the type code is wrong) or if you want to verify that your firmware type is correct. 

The printer firmware files are named similar to the following. 

INVENT3D v2.3-11 

The beginning of the name is the name of the printer, INVENT3D.  The number at the end is a 

compilation of the firmware version and printer type.  The firmware version above is 2.3 and is located 

after the v and before the – mark.  The printer type is after the – mark.  A table of current types is listed 

below along with identification details. 
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INVENT3D standard printers 

Ver 1 hot end Ver 2 hot end Ver 3 hot end  

1 11 21 31 Full sized Rambo 

 12 22 32 Mini Rambo 

 

INVENT3D heated bed printers 

Ver 1 hot end Ver 2 hot end Ver 3 hot end  

1H 11H 21H 31H Full sized Rambo 

 12H 22H 32H Mini Rambo 

 

Our printers shipped with various heads over time with each newer head being a newer version number.  

The printer hot end version is the first number in the type.  The second number in the type refers to the 

type of Rambo board (the full Rambo board is the older type, the mini Rambo is the newer type).  

Letters after the type designation refers to modifiers to type, the notable letter is H which means a 

heated bed type printer. 

You would need to visually identify the type of head you have, the type of Rambo you have, and the 

type of printer board that you have.  From that information, refer to the table above to figure out the 

printer version. 

Version 1 hot end 

This hot end has a gray block at the 

bottom which screws into a black feed 

chamber.  These hot ends feature one 

prominent fan above the HOT! sign and 

may feature one fan to the right hand 

side.  The brass nozzle at the bottom is 

of a significant size. 
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Version 2 hot end 

This hot end features two fans to the right of the hot end that is attached to the hot end.  The hot end is 

entirely silver and is directly screwed into a small brass tip.  There is no square block above the brass tip. 

This hot end is under recall due to a fragile thermistor design and should be replaced by a version 3 hot 

end. 
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Version 3 hot end 

This hot end features a single cooling fan that is attached to the hot end (this fan will likely be on the 

right side).  This hot end has a silver block below the cooling fins area and attached to that block is a 

small brass tip.  This hot end also features blue braided wires that come out of the printer (that may or 

may not be visible). 
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Full Rambo board 

This board features another circuit board that is physically attached to the top of it.  This board has large 

block connectors on the left side of the board (shown prominently in the photo). This board only 

features one automotive style fuse (a blue fuse on the left hand side). 

 

Mini Rambo board 

This board (shown to left) is a clean design 

with no other circuit board attached to it.  

The board has large block connectors at the 

rear and rear right of the board.  A notable 

difference, this board has three automotive 

style fuses (one blue 15 amp and two brown 

5 amp fuses). 

 


